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Happy Birthday Dear Newsletter!

Eight conferences, 17 MVP awards, one Lifetime 
Achievement Award, six books, 1,284 articles, 837 
keyboard shortcuts, 117 readers’ questions and a  
whopping 2936 pages – we turn 10!! 
I am feeling TEN-acious this month – except the time seems to have flown by, rather than us “limpet” to here…  Sorry, I TENd to make bad jokes on 
such anniversaries – it’s best you pay atTENtion… (please stop – Ed.)

Sadly, by our publishing deadline day, no Power BI updates were announced, but there is still more than enough to keep you occupied in this 
landmark birthday issue.  We get all reflective with Best Practice considerations, show how to avoid circularity on interest calculations and revisit 
some readers’ questions.

But then we also add in the staple diet of another Beat the Boredom Challenge, together with Charts & Dashboards, Visual 
Basics, Power Pivot Principles, Power Query Pointers and Excel Updates.  You can find out why the first three letters of 
“irrelevant” are IRR in the A to Z of Excel functions series and we finish off the celebrations with yet more CTRL + SHIFT 
keyboard shortcuts.

As always, happy reading and remember: stay safe, stay happy, stay healthy.
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We turned 10!  It won’t be long now before this newsletter becomes a moody teenager…

A lot has happened in the past 10 years to both the newsletter and to all of us here at SumProduct.  
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So what’s been our crowning glory in the past 10 years?  You may or may 
not be familiar with the first two books in this series, An Introduction to 
Financial Modelling and Continuing Financial Modelling, but we thought 
we peaked with Financial Modelling in Power BI (third time lucky, I 
suppose!).  From covering how to model in Excel, we moved on to all 
things visual.

Power BI – Microsoft’s self-service business intelligence and data 
visualisation tool – has become both more versatile and more popular 
as time goes by.  Today’s analysts need to use the best, most powerful 
and flexible analytical software for their work.  More and more of us are 
realising Power BI fits the bill.  We would have been foolish to stand still.

In the 121 newsletters we’ve put together in the past 10 years, there is 
certainly one point to get across – CraFT.  We have written about it from 
time to time in these weighty tomes, but now seems as good a time as 
ever to revisit the “Best Practice” principles of building a spreadsheet.

Most spreadsheets serve a purpose, typically to communicate a forecast, 
evaluate a project or undertake some other form of quantitative analysis.  
Note the verb: communicate.  They are communicative tools first and 

foremost.  However, that communication is frequently sullied by poor 
layouts, insufficient labels and inconsistencies which cause end users 
difficulties in understanding the model purpose and content.  These 
issues can cause unnecessary extra work for the model builder, difficulty 
in comprehension for the decision maker and lead to conclusions based 
upon errors in logic and / or formulae which are not readily identifiable 
/ visible.  

This recently released book addresses the way forward for financial 
modelling.  Many working in banking and finance are creating their 
financial models in Excel and then importing them into Power BI for 
graphical interpretation and further analysis.  That’s not what we do 
here: we went and built the model in Power BI.

If you can build the calculations for financial statements in Power BI, you 
can produce statements by product, by customer, by geography, by …  
Get the picture?  The limitation will be restricted to the granularity of the 
underlying data.  If you build the statements elsewhere and import them 
in, how do you propose drilling down to that level of detail?

Newsflash: you can’t.

Whilst there is nothing wrong with building financial models in Excel or 
else download them from some third party management information 
system, this represents the next step.  It’s evolution.  You can carry on 
building interactive spreadsheets if you wish.  But this will take you to 
the next level in a thought provoking manner, and give you an advantage 
over your peers when it comes to financial modelling, analysis and 
forecasting.

This isn’t meant to be a sales pitch (hopefully, you know us better than 
this now).  We’re very excited to release this ground-breaking book.  You 
can order your copy now from Amazon or directly from Holy Macro books.

Arguably Our Proudest Achievement

One Thing You Should Know…

mailto:contact@sumproduct.com
http://www.sumproduct.com
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Therefore, you should put some thought into designing your spreadsheets and not just the formulae.  “Best Practice” should be considered a proper 
noun to reflect the idea that a good model has four key attributes we call CRaFT:

•	 Consistency

•	 Robustness

•	 Flexibility

•	 Transparency.

With this borne in mind, allow us to explain how we think when putting a worksheet together.  To begin with, let’s start with a blank worksheet:

Building an effective communication tool by laying out an appropriate 
financial model is simple: it’s all about designing and scoping.  The 
problem is, we are all time poor in today’s business environment with 
perpetual pressure on producing results more and more quickly.  Getting 
a layout structure won’t solve all of your problems but it’s a start.

Let me show you how you could develop this basic worksheet.  Assuming 
this isn’t a dashboard output page where column widths may be more 
critical, we tend to narrow the first few columns (highlight columns, then 
right-click and select ‘Column width…’ from the pop-up context menu):

It may not be clear why we choose to do this, but read on (hey, I need to keep you on the edge of your seat!).  We’ll choose a width of 3 as this 
effectively makes the cells in these columns square.

mailto:contact@sumproduct.com
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You can elect to highlight a different number of columns and you can modify the width too.  There are two key points to this:

	 1.	 Keep column A blank other than for the sheet headings (explained later)
	 2.	 Be consistent, both with the widths of the columns narrowed here and with other worksheets within the same workbook (again, to be  
		  explained shortly).

Next, let’s put the sheet title in cell A1.  This should be the same as the description in the sheet tab.  For the purposes of this example, I am going to 
call it “Sheet Title” to emphasise the purpose of this placeholder, but without the quotation marks:

There are three reasons for this:

	 1.	 Given that sheet tab names cannot be infinitely long, sheet title is more succinct and easier for the end user to understand

	 2.	 Given that the sheet title appears on the worksheet, the name has to be written formally and cannot be an incomprehensible abbreviation,  
		  similar to many sheet tab names out there

	 3.	 This approach promotes consistency, one of the four key concepts of Best Practice modelling.

In cell A2, we will put the model name.  This is important as often we only show extracts of a workbook in an appendix to a report or a PowerPoint 
presentation.  Therefore, we’ll place it here rather than in the header or footer of each worksheet instead (but you may do both):

If you intend to add this to the header or footer, these attributes may 
be accessed by the keyboard shortcut ALT + P + SP -> ‘Header / Footer’ 
tab -> ‘Custom Footer…’ button.  I acknowledge it’s simpler than my 
alternative, but this filename will only display when the worksheet is 

printed.  What if it is an image on a PowerPoint slide or, say, as Appendix 
4 in a Word document?  This is why we keep the model name front and 
centre on my worksheets.

There’s a formula too:

=IFERROR(MID(CELL("filename",A1),FIND("[",CELL("filename",A1))+1,FIND("]",CELL("filename",A1))-FIND("[",CELL("filename",A1))-1),"")

mailto:contact@sumproduct.com
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The next key item to position at the top of the sheet is a navigation aid.  Today’s workbooks can be quite complex with many worksheets.  We 
recommend incorporating a central navigation page – a “Table of Contents” – which allows the end user to traverse the workbook quickly and easily.

It looks like I have added a hyperlink in cell A3, right?  Not quite.  I am a little craftier than that.  Actually, I have highlighted cells A3:F3 and then 
merged the cells using Excel’s Merge Across functionality (ALT + H + M + A):

Hyperlinks may be created easily using the keyboard shortcut CTRL + K (or click the ‘Link’ button on the ‘Insert’ tab) to link to a place in your 
document.  The intention is to set up a central Table of Contents worksheet where all of the hyperlinks to the other worksheets reside:

The hyperlink should link to cell A1 (say) of that worksheet and that cell 
should have a range name such HL_TOC.  A range name is essential in 
order to avoid a broken link should someone rename the destination 
worksheet and ‘HL’ simply denotes that the cell is used as the destination 

for a hyperlink.  The reason cells A3:F3 are merged is so that if the end 
user clicks anywhere in that range the hyperlink will activate; otherwise, 
the user will have to click on cell A3 only for the hyperlink to work.

This brings us on nicely to cell A4:

mailto:contact@sumproduct.com
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We can add a formula here to summarise all / any error checks present in the model.  Typically, to conserve real estate on the worksheet, dates and 
other headings may share this row too:

You may have noticed as well that there is a line inserted in between rows 4 and 5 of our image:

	 •	 Freeze top row: Keeps the top row visible no matter how far down the spreadsheet you scroll

	 •	 Freeze first column: Keeps the first column visible no matter how far to the right you scroll the spreadsheet

	 •	 Custom (Freeze Panes): Creates a frozen locus at the intersection of the top row and the first column of the cell(s) selected.

That final option is a little confusing.  Essentially the frozen panes are created as follows:

This is not a drawn line.  This is called a frozen pane.  Frozen panes break up the worksheet in to as many four pieces and allow parts of the worksheet 
to remain on view (“be frozen”) whilst the reader scrolls down or across the worksheet.  Located in the ‘Window’ grouping of the ‘View’ tab of the 
Ribbon, there are three ways to create a frozen pane:

In my layout, I have made column G my Units column: down this column 
I shall put in all of my units so end users may distinguish between 
numerical fields.  How often have you seen an output printed out and 
not known if it is in $, $’000, $m, kg or sliced tomatoes?  This will make 
this issue a thing of the past.  It should be noted that this column is not 
always required.  For instance, on an outputs worksheet, you may simply 
state near the top of the sheet, “All outputs are displayed in $m unless 
stated otherwise”. 

Cells J4:N4 contain the date headings.  The dates should be periodic 
(e.g. monthly, quarterly, annually) and should always start and end 
in the same columns (and rows) on each forecast worksheet.  That is 
not always possible: sometimes, you require some of you model to be 
annually forecast and other aspects monthly.  Where different reporting 
periodicities are necessary, these inconsistent worksheets should be 
clearly delineated from other areas of the workbook. 

mailto:contact@sumproduct.com
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These have been labelled “Headings” and “Sub Headings” etc. to make it clear, but this approach will become cumbersome quickly.  Renaming the 
headings “Heading 1” and so is clearer.  This also makes them consistent with pre-existing Style names (hint, hint):

Aside from keeping column A clear, do you now see why we have 
narrowed columns B, C and D (we are keeping column E “just in case”)?  
The narrowing of the columns effectively indents the headings and 
makes worksheets easier to read and navigate (especially if the gridlines, 
ALT + W + VG, are toggled off).

Take special note of the spacing: one blank row between headings; two 
lines between sections.  That’s our preference.  You choose your own if 

you would prefer – just be consistent.  It makes it very simple to copy 
sections and keep referencing if spacing is deliberate.

Blank columns H and I are in existence in case we have any calculations, 
inputs or referred values that do not refer to a particular time period.  If 
they are not required, we tend to narrow the columns to a width of 1 
(say), so that they are still there in case they are needed later.

Frozen panes are created for the region the selection is in, the region 
directly above, the region to the immediate left and diagonally opposite 
the top left-hand corner of the selection.  If the selection were in column 
A, there would only be two frozen panes: the rows immediately above 
and the remainder of the sheet.  If the selection were in row 1, again, 
there would only be two frozen panes: the columns to the left and the 
remainder.

In our example, cell A5 has been made the basis of the frozen pane, so 
that rows 1 to 4 will always be visible.  This cell should be given a range 
name, e.g. HL_Home, as this is the cell hyperlinks to this sheet should 

link.  This cell ‘resets’ the sheet when a frozen pane has been added 
(not cell A1) and makes the model easier to navigate consequently.  This 
cell can always be identified by employing the keyboard shortcut CTRL 
+ HOME.

At this point, let’s revisit my unexplained narrowing of the first few 
columns.  Here at SumProduct, we would suggest headings should start 
in column B, not A, and then move out a column or two for sub headings 
and sub sub headings respectively.  This causes a natural indentation.  
We then put data labels directly beneath sub sub headings:

mailto:contact@sumproduct.com
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Adding labels, data and formulae:

It’s starting to look more like a spreadsheet now.  The next step is to incorporate Styles (ALT + H + J):

mailto:contact@sumproduct.com
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Very quickly, our spreadsheet is taking shape:

If I switch off gridlines on my spreadsheets, then the majority of my files 
appear to have a white background.  There is more to this point than 
merely aesthetics.  Adding a colour to the background of a spreadsheet 
can make a file significantly larger – unnecessarily.  

The spacing is deliberate too.  Not only does it look neater (remember, 
Excel 2007 onwards has 1,048,576 rows and 16,384 columns, i.e. it is 
1,024 times larger than an Excel 2003 worksheet so there is plenty of 
room), but the space is functional too.

Want to navigate between the main headings in column B?  Click on cell 
B6, go CTRL + Down Arrow and you will arrive at cell B18.  Repeat this 
action and the next cell you will hit is cell B1048576, i.e. the very bottom 
of the spreadsheet because there is nothing else in this column.  

Click on cell D10 (Heading 3) and use the keyboard shortcut CTRL + 
Down Arrow to take you to cell D15, the final cell in the contiguous 
range.  CTRL + Up Arrow, CTRL + Right Arrow and CTRL + Left Arrow will 
all perform similar actions.  Need to highlight a range?  Click on any cell 
within the range and CTRL + A will select the whole contiguous range.  

This makes the model easier for developer and user alike to navigate 
and manipulate.

So why have we kept column A blank?  The reason is to take into account 
work in progress.  How often have you started creating a spreadsheet 
only to be interrupted, have to go to a meeting, take a telephone call, go 
home or go to sleep?  The point is, when we are interrupted, we need to 
remember how far along we were.  If you design a spreadsheet similar 
to the one discussed here, imagine you are interrupted without notice.   
Before you turn your attention to the disruption, whichever row you are 
working on, press the HOME key which will take you to column A of 
that row.  Type anything in that cell, e.g. “w” for “work in progress” or 
“check” and so on.  That’s it.

To conclude, whatever you decide to do, keep it consistent, make it 
transparent, ensure there are checks to protect the robustness and that 
inputs are clearly marked to aid flexibility.  Any layout addressing these 
points will necessarily adhere to the CRaFT ideology.

When a formula refers back to its own cell, either directly or indirectly, it is called a circular reference.  Microsoft Excel cannot automatically calculate 
all open workbooks when one or more of them contains a circular reference and usually will put zero as the default value in the cell(s) instead.

You can remove a circular reference, or you can have Excel calculate each cell involved in the circular reference using the ‘calculate iterations’ 
feature.  This requires you enabling iterations:

	 •	 go to Excel Options (ALT + T + O)
	 •	 choose ‘Formulas’ from the list in the left-hand column

	 •	 in the first section, ‘Calculation options’, ensure the check box ‘Enable iterative calculation’ is checked

	 •	 amend the ‘Maximum Number of Iterations’ (maximum is still 32,767) as required

	 •	 amend the ‘Maximum Change’ as required (the smaller the number, the longer it will take for Excel to calculate the answer)

	 •	 click ‘OK’.

Back in the early days of the SumProduct website, this article was one of the most popular topics and is still requested by many.  It is still one of our 
top-ranked articles ever.  So where better to reproduce it than in our 10th birthday newsletter!

Blast from the Past: Avoiding Circularity When Modelling Circularity

mailto:contact@sumproduct.com
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Various problems may arise with circular references:

	 •	 many users will agree that circular arguments can cause the Excel file to become unstable and even crash

	 •	 when solved, Excel may give one solution when there may be several, only one of which is correct in the given circumstances.  If the 	
		  problem is not fully understood, the danger is an incorrect solution may be accepted

	 •	 if Excel stops calculating after a given number of iterations / when the difference between iterations becomes miniscule, users expect the 	
		  resulting values to be a solution when it may not be (you must always verify that the value reported provides the result required).

Therefore, circular arguments are not recommended, although it is conceded on occasion there may be no alternative viable solution.

Calculating interest without circularity

In a financial model, it is commonplace to have to calculate interest.  For this illustration, let’s assume we are calculating interest received on the 
business’s average cash balance for certain periods of time (it could just as simply be interest paid on a debt balance, etc.).  This gives rise to a 
perceived circular logic:

This problem can be solved algebraically in, er, a relatively straightforward manner without creating circularities – and is therefore our recommended 
approach.  

In a newsletter, we wouldn’t normally publish the following, but the derivation of the formula has proved to be one of our most popular web 
pages (see http://www.sumproduct.com/thought/interest-received).  Therefore, we apologise for the following mathematical assault (for those 
not interested in the derivation, simply skip to the end) – unfortunately, Excel modelling sometimes boils down to solving simultaneous equations!  

So, 	 CB		  =	 OB + M ( 1 – t ) + I ( 1 – t )		  and	

	 I ( 1 – t )		  = 	 ( x.OB + ( 1 – x ).CB ).r.( 1 – t )	 so (as t ≠ 100%)

	 I	 	 = 	 ( x.OB + ( 1 – x ).CB ).r

			   =	 ( x.OB + ( 1 – x ).( OB + M ( 1 – t ) + I ( 1 – t ) ) ).r

			   =	 OB.r + ( 1 – x ).M.( 1 – t ).r + ( 1 – x ).I.( 1 – t ).r

OB = opening cash balance for the period

CB = closing cash balance for the period

M = non-interest cash movement for the period

I = interest cash movement for the period

r = interest rate

t = tax rate (it is assumed this cannot equal 100%)

x = proportion into the period that the non-interest cash movements are assumed to occur, e.g.

	 •  If x = 0%, this means the movement occurred at the start of the period
	 •  If x = 100%, this means that the movement occurred at the end of the period
	 •  If x = 50%, this means that the movement occurred midway through the period

Let:
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Therefore,

	 	 I.( 1 – (1 – x ).( 1 – t ).r )	 =	 OB.r + ( 1 – x ).M.( 1 – t ).r

	 	 	 <=>	 I	 =	 OB.r + ( 1 – x ).M.( 1 – t ).r 
						          ( 1 – (1 – x ).( 1 – t ).r )

Hence, we can calculate interest from this final equation and have no circular references or goal seek.  Please see http://www.sumproduct.com/
thought/interest-received for an example Excel file that illustrates this technique:

Where would we be without our readers and their questions?  Whilst our specific replies are a little sporadic, we deal with common questions 
through each and every newsletter.  Below are some of those we specifically provided short form responses too for this special edition newsletter.

Any Questions..?	

Question Answer

What is the maximum number of functions 
you nest in an Excel formula?

Excel 2003 and earlier allowed seven nesting levels; Excel 2007 and later allow 64.  We will 
only allow you two.  After this you will be taken outside and shot.

Nesting functions usually occur when the modeller is unaware there is a better function / 
formula to use.

How do you round a number to the nearest 
odd or even number?

Use the formulae

=ODD(ROUND(Number,0)) and =EVEN(Round(Number,0))
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Is it possible to select all objects in a sheet 
simultaneously?

Yes:

	 •  Press the shortcut key F5 to open the ‘Go To’ dialog box
	 •  Click on the ‘Special…’ button

	 •  Select ‘Objects’ radio button

	 •  Click ‘OK’

	 •  All objects will get selected

I notice if I enter ‘January’ in one cell and then 
‘February’ in the next cell and drag down (or 
across) the remaining months autofill.  Is it 
possible to do this with common lists used at 
my company?

Absolutely!  Go to ‘Excel Options’ (ALT + T + O) and select ‘Advanced’ from the column menu.  
Scroll down the main pane to ‘General’ and click on the ‘Edit Custom Lists…’ button.  Type in 
your list or import it from an Excel range and click the ‘Add’ button.  Done!

I cannot find where something is on the 
Ribbon – or even if it is there.  How can I find 
it and make it easier to find going forward?

Microsoft has developed a range of interactive guides such as those that can be found at 
https://www.microsoft.com/en-us/download/search.aspx?q=interactive+menu+to+ribbon+
guide.

They are ok, but another useful resource often forgotten about is the Quick Access Toolbar.  
Right-click on the Quick Access Toolbar in Excel and then choose ‘Customize Quick Access 
Toolbar…’ from the shortcut menu (or else select ‘Excel Options, ALT + T + O and then ‘Quick 
Access Toolbar’ from the columnar menu).  Select ‘All Commands’ from the ‘Choose commands 
from:’ drop down menu.  All commands will be listed alphabetically in the pane below the 
drop down box.  Seek out what you are looking for, highlight the command and press the ‘Add’ 
button.  It will now be on your Quick Access toolbar for easy future access.

Is it possible to create a PivotTable from 
more than one source without using Power 
Pivot?

There are ways and means to wriggle around this problem.  It’s easy if the data is all in multiple 
ranges of the same workbook (simply use the hidden ‘wizard’, ALT + D + P) and select ‘Multiple 
consolidation ranges’.  However, it is simpler to use Power Pivot if you are using Excel 2010 
or later.

mailto:contact@sumproduct.com
http://www.sumproduct.com
https://www.microsoft.com/en-us/download/search.aspx?q=interactive+menu+to+ribbon+guide
https://www.microsoft.com/en-us/download/search.aspx?q=interactive+menu+to+ribbon+guide


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Drop us a line at training@sumproduct.com for more details on Power Pivot.    

I have accidentally created an add-in by 
saving one of my Excel files as an “add-in” 
type.  Going to Tools-> Add-Ins, I cannot 
seem to remove it.  How can it be deleted?

Easy.  Move the offending file to a different location temporarily whilst Excel is closed.  You 
may get an error message about this add-in upon opening Excel.  Then, open Excel and open 
the ‘Add-ins’ dialog box.  Check on the ‘phantom’ add-in.  Excel will say it cannot find it and 
ask whether you wish to delete it from the list.  Click ‘Yes’ and then move your Excel file back 
to its original location.  All done.

How can I make the text on my Formula bar 
larger?

Go to ‘Excel Options’ (ALT + T + O), then select ‘General’ from the columnar menu.  In the 
‘When creating new workbooks’ section, change the font size.  You will need to restart Excel 
for the effects to take place.

How can I make all comments in the cells on a 
particular worksheet appear simultaneously?

This appears to be a little-known feature in Excel for some reason.  Go to the ‘Review’ tab on 
the Ribbon and in the ‘Comments’ grouping select ‘Show All Comments’.
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Can you embed videos in Excel? This is an unusual query, but yes, you can although we are not sure we recommend it.  Go the 
‘Insert’ tab on the Ribbon and then click on ‘Object’ in the ‘Text’ grouping (obviously!).  Click 
on the ‘Create from File’ tab in the ‘Object’ dialog box and browse to the video.  Check the 
‘Display as icon’ box (checking ‘Link to file’ links rather than embeds the video) and then click 
‘OK’ (you can change the icon by pressing the ‘Change icon…’ button).

Do note this make the Excel file very large!!

I need to refer to every fourth row in a block 
of cells, e.g. cell A1 has the formula =A15, 
cell A2 has the formula =A19, cell A3 has the 
formula =A23 and so on.  Is there a quick way 
to create these formulae without having to 
write out the calculation in each row?

Yes – and this technique works for any pattern where an equal number of rows is omitted each 
time.  Type an apostrophe in front of the formula in cell A1, so that it becomes ‘=A15.  Do the 
same for A2, i.e. the formula becomes ‘=A19.  Now copy these formulae down.  You will get 
‘=A23, ‘=A27 and so on.  Now highlight all of these formulae and on the ‘Data’ tab, click on the 
‘Text to Columns’ icon in the ‘Data Tools’ grouping.  When the dialog box appears, just click on 
the ‘Finish’ button.  It's as simple as that!

I use certain files all of the time, although 
they may not appear in my recent list.  Is 
there a quick way to access them without 
having to go File->Open and browse to the 
appropriate directory?

Yes.  Open the file in Excel and then return to what is known as the ‘backstage’ area by clicking 
on the file tab.  You will now see your file in the list of recently opened files.  

You will see a ‘pin’ to the right of each file recently opened.  Click on this and it will ‘pin’ this 
file so that it is always visible when you are selecting a file to open.
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How can I find the first item in a list that is a 
case sensitive match for what I am searching 
for?

Use the formula 

{=MATCH(TRUE,EXACT(Criterion,List),0)}

This is entered as an array formula (CTRL + SHIFT + ENTER) – so braces are not manually 
entered.

Please see https://www.sumproduct.com/thought/index-match for further information.

How can I count the number of unique items 
in an Excel list if I don’t have access to Excel 
365 / dynamic arrays?

Use the formula

=SUMPRODUCT((List<>"")/COUNTIF(List,List&""))

to count the number of unique items in the List.  For more information, please see  
https://www.sumproduct.com/thought/sumproduct-squared.

How can I create a list of the unique entries 
from a list in Excel which may contain 
duplicates when I don’t have access to Excel 
365 / dynamic arrays?

This is when you should use the ‘Advanced Filter’ in Excel, located in the ‘Sort & Filter’ grouping 
of the ‘Data’ tab.  

Depending upon whether your list has a heading or not, the ‘Advanced Filter’ may prompt you 
to elect whether the list contains a heading (to be ignored).  

Select the Range and the Location where the unique list should be created.  Then, complete 
the dialog box as follows:

How can I get numbers in millions to 
appear in millions, numbers in thousands in 
thousands and others in units?

Use custom number formatting.  Click on the cells to be formatted and then use the 
keyboard shortcut CTRL + 1 to Format Cells.  Select ‘Custom’ on the ‘Number’ tab and use 
syntax such as

[>=1000000]#,##0,,”m”;[>=1000]#,##0,”k”;#,##0

For more information on number formatting, please refer to https://www.sumproduct.com/
thought/number-formatting.

How can I express a decimal as a fraction in 
Excel?

Use the formula

=TEXT(Decimal,”? ?/?”)

What is the quickest way to negate a set of 
input data?

Of course, you can always fall back on the formula =-Cell_Reference, but if you just want all of 
the inputs to be negated in one go, simply type -1 into a cell and then copy it.  Then, highlight 
the data you wish to negate and Paste Special as Values (ALT + E + S + V) using the Multiply 
operator.  Simple!
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How do I find the third largest value in a set 
of data?

Use the LARGE function: =LARGE(Data, n) returns the nth largest value in the Data.  SMALL 
works similarly but finds the nth smallest.

How do I find the sum of the first 10 items in 
a list even if the list may have rows inserted 
or deleted (i.e. it always sums the first 10)?

Use the formula

=TEXT(Decimal,”? ?/?”)

What is the quickest way to negate a set of 
input data?

Assume the range to be summed initially is the selection A1:A10.  The formula 

=INDIRECT(“A1:A10”)

will always sum this range regardless of how many rows are added or deleted.  

For more information on the INDIRECT function, please see https://www.sumproduct.com/
thought/being-direct-about-indirect.

With many of us currently “working from home” / quarantined, there are only so Zoom / Teams calls and virtual parties you can make before you 
reach your (data) limit.  Perhaps they should measure data allowance in blood pressure millimetres of mercury (mmHg).  To try and keep our readers 
engaged, we will continue to reproduce some of our popular Final Friday Fix challenges from yesteryear in this and upcoming newsletters.  One 
suggested solution may be found later in this newsletter.  Here’s this month’s…

This one may have gone into legend these days, but after a challenge laid 
down way back in 2015, this was voted SumProduct’s (Liam Bastick’s??) 
Top Tip.  Use this one at your peril – used in the workplace, it may spell 

the end of your career…  We thought we’d keep the nostalgia by retaining 
the screen grabs from the time!

Sometimes, when you work with pivoted data that has a structure similar 
to a PivotTable, it is difficult to look up a value based on multiple column 
and row criteria.  To make it simpler, we usually unpivot the data.  Most of 
the time, you may choose to use the ‘Unpivot Columns’ feature in Power 
Query (please see https://www.sumproduct.com/blog/article/power-
query-blogs/power-query-6-painless-unpivoting?L=0 for more details).

This challenge is designed to make you think outside the box to find 
another way using only Excel formulae.

This month’s challenge is to write a formula in one cell using dynamic 
arrays (please see https://www.sumproduct.com/thought/getting-
arrays-spilling-the-beans-on-seven-new-functions?L=0 for more details) 
that will spill a range of cells to unpivot only the last three [3] columns 
(i.e. x, y and z) of an array.  Assuming the example on the left (below), the 
result should look like the array generated on the right:

As always, there are some requirements:

	 •	 the formula needs to be in just one cell (no “helper” cells)

	 •	 this is a formula challenge; no Power Query / Get & Transform or VBA!

	 •	 the formula needs to be flexible, so that if we adjust the number of rows and / or columns of the input table, the formula should still work

	 •	 obviously, the numbers of rows / columns of the output table cannot exceed the row / column limitations of Excel.

Sound easy?  Try it.  One solution just might be found later in this newsletter – but no reading ahead!  

We have some twisted individuals reading this newsletter!  By far and away the most popular ‘trick’ (in all sense of the word!) was this monster first 
divulged in our very first newsletter by our own resident MVP Liam Bastick.  We have elected not to name all the people who suggested this – partly 
to save printing costs and partly to protect the guilty.  You know who you are!!

Beat the Boredom Challenge	

Our Top Ranked Tip	
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Data Validation is a useful way to control what end users can type into 
a worksheet cell (see http://www.sumproduct.com/thought/data-
validation).  You can use this functionality to play a trick.  Please use this 
at your own risk: if you get fired, you will get no sympathy here and we 
will disown all knowledge: this article will self-destruct in five seconds...

If someone is unfortunate to leave a spreadsheet unprotected, simply 
highlight the whole worksheet and then activate Data Validation  
(ALT + D + L).  In the ‘Settings’ tab, select settings similar to the following 
(the aim is to pick a number the user won’t use):

Then, select the ‘Error Alert’ tab:

If you are feeling particularly horrible, add “Press any key to continue” to this message for maximum effect.  Now, de-select the range and wait for 
your victim to use the worksheet.  As soon as they type an invalid entry, they will be greeted with the following error alert:

Who says spreadsheets can’t be fun..? 
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When creating charts with time series, you should not skip periods: if 
data only exists for seven [7] months of the year, your graph might still 
be best placed to show all 12 months, so as to remove any chance of 
the information being misinterpreted.  If the reader sees seven columns 
on a graph, they may not notice that five [5] months of zero results are 

missing.  When creating charts measuring values, typically these would 
go on the vertical axis and you should always show zero [0].

For example, imagine we have to chart selected data, but my data series 
is somewhat incomplete:

If you have ever created a Line chart, have you ever witnessed the following?

In this instance, Excel has assumed the missing values are zero [0].  Alternatively, you may see the following:

It’s time to chart our progress with an introductory series into the world of creating charts and dashboards in Excel.  After looking at how to highlight 
data last month, this time we look at how to hide data instead.

Charts and Dashboards	
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The trick is to review the settings regarding how Excel displays hidden and empty cells.  To get there, right-click on any part of the chart, then select 
‘Select Data’, and then select the ‘Hidden and Empty Cells’ option, viz.

The ‘Hidden and Empty Cell Settings’ dialog will appear:

Here, Excel has drawn a line in place of the missing data points.  However, we actually want the chart to display like this:
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This chart is the result of setting ‘Show empty cells as: Gaps’:

This chart is the result of setting ‘Show empty cells as: Zero’:

This chart is the result of setting ‘Show empty cells as: Connect data points with line’: 

This helps end users be better able to understand the charts presented – including alerting them to what data may be missing, etc.

More next month…
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We thought we’d run an elementary series going through the rudiments of Visual Basic for Applications (VBA) as a springboard for newer users.  This 
month, we look VBA up and down…

In last month’s newsletter, we set the After parameter for the Find 
method to distinguish which cell we wanted to start from.  However, we 
noted that it defaulted to go across the row.  It may be set in order to go 
down the columns first using the SearchOrder parameter.  This is where 
we need to look at how VBA handles parameters.  

When we type the Find method and open the brackets, we will see the 
ToolTip for the parameter list, identical to when we use functions in 
Excel formulae.

The bolded parameter is the one we are currently entering.  The parameters in square brackets are the Optional parameters.  We could skip to 
SearchOrder using:

searchRange.Find("up", Range("C5"), , , xlByColumns)

However, this isn’t a good approach.  It is very easy (and we will admit to having done this) to put the wrong number of commas in and have the 
subroutine fail at that point in the code.

Instead, VBA allows us to assign values to specific parameters directly.  This is performed by naming the parameter followed by “:=” then the value.  
In the previous example, that line is better written as:

searchRange.Find("up", After:=Range("C5"), SearchOrder:=xlByColumns)

With that borne in mind, our full subroutine will look like this:

Sub FindAfterByColumns()

    Dim searchRange As Range

    Set searchRange = Range("A1:E10")  

    Dim foundrange As Range

    Set foundrange = searchRange.Find("up", After:=Range("C5"), SearchOrder:=xlByColumns)

    If foundrange Is Nothing Then

        Debug.Print "not found!"

    Else

        Debug.Print foundrange

        Debug.Print foundrange.Address

    End If

End Sub

This results in the following:

Next newsletter, we will pinpoint exactly how to dig up our column!

Until then.

Visual Basics	
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We continue our series on the Excel COM add-in, Power Pivot.  This month, we discuss how to use a combination of disconnected tables and variables 
to produce unique slicers in Power BI and then consider a similar dynamic toggle for Power Pivot.

To begin (assuming we already have all of our data loaded into Power BI and created measures to calculate the sales for Divisions 1, 2, 3, and All 
Divisions), we need to create a disconnected table with our four [4] categories.  We can upload a pre-built table from Excel to detail this categorisation:

compared with

Alternatively, we can create a table directly in Power BI using the ‘Enter Data’ button on the Ribbon (but do not link this table to any other table in 
the dataset):

This month, we are going to do a bit of a crossover between Power Pivot’s 
Data Analysis eXpressions (DAX) language and Power BI.  As you may 
know, Power BI also uses DAX to create measures and process data just 
like Power Pivot.  The reason why we will be using Power BI initially is 
because the SELECTEDVALUE function detailed below just isn’t available in 
Power Pivot’s DAX library – yet. 

We are going to create a slicer that is connected to a disconnected table 

(see https://www.sumproduct.com/blog/article/power-pivot-principles/
ppp-disconnected-tables-and-exchange-rates for further details).  

Whilst the slicer will have a direct effect on the disconnected table, 
the table has no link to all of the other tables currently in our dataset.  
However, through using variables, the SELECTEDVALUE and the SWITCH 
function, we will be able to manipulate the visualisations on our 
dashboard, viz.

Power Pivot Principles
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The next step is to create a slicer with the ‘Division’ table:

Now on to the measure.  If you need to catch up on what variables are in DAX (employed below), we have an article (https://www.sumproduct.com/
blog/article/power-pivot-principles/ppp-variables-in-dax)  that you may read. 

We will use the DAX expression:

Values = 

VAR DivisionNo =  

SELECTEDVALUE(‘Division Type’[Division], [All Divisions])

RETURN

SWITCH(TRUE(),

DivisionNo = "Division 1", [Division 1],

DivisionNo = "Division 2", [Division 2],

DivisionNo = "Division 3", [Division 3],

[All Divisions])

We use the SELECTEDVALUE function to declare the value that will be used by the variable ‘DivisionNo’.  The [All Divisions] measure in the 
SELECTEDVALUE formula specifies the function to return (with the sum of all divisions) should none be selected.

VAR DivisionNo = 

SELECTEDVALUE(‘Division Type’[Division], [All Divisions])

Then, we shall utilise DivisionNo’s value to call one of three measures that calculates the actual, budgeted or forecasted sales.  Distinguishing 
between the three measures is achieved using the SWITCH function:

RETURN

SWITCH(TRUE(),

DivisionNo = "Division 1", [Division 1],

DivisionNo = "Division 2", [Division 2],

DivisionNo = "Division 3", [Division 3],
	 [All Divisions])

The final step is to insert the Values field into any visualisations where we want to be able to switch between actual, budgeted or forecast sales.
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We can now toggle freely between the three divisions that we have specified and have the visualisations updated accordingly.

It should be noted that we do not need to worry about our users selecting two or three options in the slicer.  We’ve deliberately left ‘Single Select’ 
on which does not allow for multiple option selections in the slicer. 

So far, so good.  Now that we’ve detailed a method using variables and 
disconnected tables to create a dynamic toggle to display our data in 
Power BI, let’s refer to Power Pivot – given this is what this article is 
supposed to be about!

We are now going to revisit the dynamic toggle from above and construct 
it with Power Pivot in Excel.  As aforementioned, the SELECTEDVALUE 
function is not in Power Pivot’s DAX library.  Therefore, we have to use a 
combination of functions to replicate the formula in Power Pivot. 

To replicate the SELECTEDVALUE result we have to use a combination of 
the IF, HASONEVALUE and VALUES functions in the following manner:

IF(HASONEVALUE('Division Types'[Division]),  
VALUES('Division Types'[Division]),[All Divisions])

The HASONEVALUE function will return with TRUE when the column 
name has been filtered down to one distinct value, otherwise it will 
return with FALSE.  This is a useful function when you want a different 
formula for subtotals and totals, for example.

The VALUES function returns with a single text value from the ‘Division 
Types’ column.  This function will not function properly if the column is 
not filtered down to a single value.  Therefore, we need to employ the 
use of the HASONEVALUE function and the IF function as an error trap 
for the measure. 

If we create the following measure with just the VALUES function: 

The PivotTable will return with the single column value from ‘Division Type’:
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Working in Excel, the VALUES function will return the following error message when there is no filter on the slicer: 

Assuming that we have imported all of the data into our data model and created the relevant relationships between our tables and slicers, we can 
construct the following PivotTable:

Moving on to the Power Pivot solution, we replace the SELECTEDVALUE segment of code from earlier:

=VAR DivisionNo = 
	 SELECTEDVALUE(‘Division Type’[Division], [All Divisions])

RETURN

SWITCH(TRUE(),
	 DivisionNo = "Division 1", [Division 1 Sales],
	 DivisionNo = "Division 2", [Division 2 Sales],
	 DivisionNo = "Division 3", [Division 3 Sales],
	 [All Divisions])

with the first piece of code detailed above to yield: 

=VAR DivisionNo = 
	 IF(HASONEVALUE('Division Types'[Division]), 
		  VALUES('Division Types'[Division]),[Division 1 Sales]
	 )

RETURN

SWITCH(TRUE(),
	 DivisionNo = "Division 1", [Division 1 Sales],
	 DivisionNo = "Division 2", [Division 2 Sales],
	 DivisionNo = "Division 3", [Division 3 Sales],
	 [All Divisions])
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Changing the selection on the slicer will yield the following:

We can now dynamically toggle between divisions in our PivotTable in Excel.

More Power Pivot Principles next month.

Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from 
www.sumproduct.com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we look at 
an example where data comes in one Excel column and needs to be converted into a table.

We have a list of names and addresses in a column.  We would like them to be in a table, where we may extract the name, address, country and post 
code (AKA zip code).  Let’s start by creating a new query from my data using the ‘From Table’ option in the ‘Get & Transform’ section on the Data tab.

Not all data arrives in Excel in nicely organised tables.  John the imaginary salesperson has sent in some new contacts, which he has copied to a 
worksheet:

Power Query Pointers
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Power Query confirms where our table is, and whether it has headers (no, thanks to John, it doesn’t!).  The default looks fine so let’s click ‘OK’.

Our data is extracted, and now we may set about transforming it into a 
useful table.  Since the data is grouped into five [5] rows for each address 
(and in this case we may rely upon this being consistent because it comes 
from a database which ensures this), it would be useful to count which 

row we are on.  We can do this by creating an index column.  In the ‘Add 
Column’ tab, let’s choose ‘Index Column’ in the ‘General’ section, and 
start my column from one [1].
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Having created this column, we now have some mathematical possibilities.

We’re going to use the function Number.Mod() to determine where 
each address starts.  Number.Mod() divides one number by another 
number and gives the remainder.  This is similar to the MOD function 
in Excel (please see https://www.sumproduct.com/thought/a-modicum-
of-mod for more details):

Number.Mod(number as nullable number, divisor as nullable number, 
optional precision as nullable number) as nullable number 

It’s much clearer to see it in practice.  To see where each address starts, 
let’s divide the index by five [5] and look at the remainder.  Here, we’ll 
create a new ‘Custom Column’ viz.

Click ‘OK’ to create a new column.
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The aim is to indicate which address lines belong together, by giving them the same value.  We’re going to do this with a running total (for more 
details on how to create a running total, please see https://www.sumproduct.com/blog/article/power-query-blogs/power-query-one-route-to-a-
running-total). 

The first step is to only count at the beginning of each address, and to do this we create another column, which this time is a ‘Conditional Column’:

This column will be one [1] for the first line and zero [0] for the rest.

We can now create another ‘Custom Column’ for our running total.
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This provides us with the same value for each line belonging to the same address.

Now we have a way to identify each address, we’re ready to pivot the data.  We no longer need the Index or Address_Key columns, so we may 
remove these first. 

On the Transform tab, select Address_Line and choose to pivot our data.  The values will be in Column1 and we do not wish to aggregate them.

Clicl ‘OK’ to see the data.

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

This is looking much better.  Our Address_ID column is populated correctly, so we just need to rename our other columns.

This data is now ready to ‘Close & Load’ to Excel from the File tab.  If John uses the same Excel worksheet and adds more addresses (or updates any 
existing ones) then they may be refreshed and updated in the table too.

More next month.

Frustratingly for our 10th anniversary edition, no Power BI updates were 
announced in time for our publishing deadline.  That’s a bit of a damp 
squib, I know, but I am sure normal service will be resumed shortly.

Power BI Updates
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The latest updates see the Navigation pane is now Generally Available for Excel for Windows, and for Windows and Mac Insiders, Automate Tasks with 
Office Scripts enables you to automate repetitive tasks in your Excel work.  There are other additions / improvements too, with the full list as follows:

Excel for the web

	 •	 Quickly ‘Find the Command’ you need

Excel for Windows

	 •	 Automate Tasks with Office Scripts (Insiders Beta)

	 •	 Navigation pane

	 •	 Quickly ‘Find the Command’ you need

	 •	 New DAX Functions in Excel Data Models and Power Pivot 	 	
	 	 (Insiders Beta)

	 •	 New Paste Options when using keyboard shortcuts (Insiders 		
	 	 Beta)

Excel for Mac

	 •	 Automate Tasks with Office Scripts (Insiders Beta).

In Excel for the web and Excel for Windows (on an Insiders Preview basis), it has just become easier to find that feature or function (i.e. “command”) 
you need using the shortcut menu.  This should save you time for other stuff and allow you to focus on the key problems at hand.

It is ever so simple to use:

	 •	 Right-click an area or object in your document, worksheet or presentation (alternatively, you may use the menu key on your keyboard or 	
		  press SHIFT + F10 to display the shortcut menu too)

Type the first few letters of the command you are looking for in the Search box at the top of the shortcut menu

	 •	 Click the command you want, or use the arrow keys to select it, and then press ENTER.

Erm, that’s it.  This feature is currently available on the following platforms and in the following applications: 

	 •	 Web: Excel, PowerPoint and Word

	 •	 Windows:  Excel, PowerPoint and Word for Office Insiders running Beta Channel and Current Channel (Preview) Version 2206  
		  (Build 15331.20010) or later.

It may take a short while to roll out so don’t panic if you don’t see it immediately.

Quickly ‘Find the Command’ you need

New Features for Excel

Let’s plough through.
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Office Scripts enables you to automate repetitive tasks in your spreadsheet workflows and automate repetitive tasks in your spreadsheet workflow 
and automate repetitive tasks in your spreadsheet workflow…

These scripts help you save time by increasing efficiency and reducing 
errors in your workflow, and you can even schedule your scripts so that 
your automations can run even while you’re away.

Up until now, you could only create these helpful scripts in Excel on 
the web.  With this update, you can now create and modify scripts in 
Excel for Windows and Excel for Mac (in Insiders Beta) using the Code 
Editor, as well as view and run scripts in the ‘All Scripts’ task pane.  This 
work represents the first stage of bringing Office Scripts across all Excel 
platforms, but we don’t imagine VBA will be quaking in its boots just yet.

To view and run scripts: 

	 •	 open any workbook in Excel for Windows or for Mac and select  
		  the Automate tab

	 •	 to run an existing script, select one in the gallery or in the ‘All  
		  Scripts’ task pane

	 •	 in the ‘All Scripts’ task pane, select any script in the gallery or  
		  click the ‘All Scripts’ button to view more detail

	 •	 to run the script you’ve selected, click the Run button on the 		
		  script’s detail page.  

To create and modify scripts: 

	 •	 open any workbook in Excel for Windows or for Mac and navigate to the Automate tab.  You should note that all the scripts in your	
		  workbook are available as well as various Microsoft samples

Automate Tasks with Office Scripts (Insiders Preview)
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	 •	 you may start making your own scripts by selecting the ‘New Script’ button

	 •	 to modify an existing script, select Edit on the script’s details page or select the pencil icon by hovering over any script in the ‘All Scripts’ 	
	 	 task pane.

As this is new, there are some known issues / restrictions:

	 •	 the ‘Action Recorder’, which records the actions you take on a worksheet and saves them into a script for you, remains a web-only feature 	
	 	 at this time (that is a shame unfortunately)

	 •	 Office Scripts in Excel for Mac does not support scripts saved to SharePoint at this time

	 •	 the Ribbon buttons do not work when logged in with a non-work / school account, or when completely logged out.  To fix this issue, switch 	
	 	 to a work or school account as your primary identity (there is no need to restart Excel).

To use Office Scripts in Excel for Windows or Excel for Mac, you must have the following:

	 •	 a commercial (E3 / E5) licence for Microsoft 365

	 •	 for Windows users only: Microsoft Edge WebView2 installed. 

This feature is available to Office Insiders running: 

	 •	 Windows: version 2209 (Build 15726.20000) or later 
	 •	 Mac: version 16.66 (Build 22092601) or later.

The Navigation pane in Excel is an easy way to understand a workbook's 
layout, see what elements exist within the workbook and navigate 
directly to those elements.  Whether you're a new user getting familiar 
with Excel or an experienced user trying to navigate a large workbook, 
the Navigation pane may prove useful.

With this pane, you can find and access elements such as tables, charts, 
PivotTables and images within your workbook.  Navigation will no longer 

be such a “pane”.  Once you've opened the Navigation pane, it displays 
on the right side of the Excel window.  The Navigation pane also makes 
it easier for those with visual impairments to access all parts of the 
workbook.  It can improve how tools such as screen readers interpret 
your workbook.

Simply click on the ‘Navigation’ button in the ‘Show’ grouping on the 
View tab of the Ribbon, viz.

Navigation pane

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

You can then navigate through the workbook with ease:

This new feature is part of Microsoft’s grand scheme to make their products inclusive and accessible to everyone, including people with disabilities.  
It’s clear that the Navigation pane will assist in:

	 •	 ensuring Excel works seamlessly with assistive technology

	 •	 building inclusive experiences for people with disabilities

	 •	 supporting authors in creating accessible content.

Excel’s Data Model and Power Pivot are tools that help you analyse 
data across multiple tables and support a powerful expression language 
called Data Analysis eXpressions (DAX).  Using the features of the Data 
Model, you can quickly relate various data sets to create PivotTables and 
Pivot Charts, using a similar technology to that employed by Power BI.

As of these updates, you may now use 92 new DAX functions when 
creating measures in Power Pivot.  This provides you with new 
capabilities to analyse, visualise and report on your data.  At the time of 
writing, there are presently 353 DAX functions available, but a significant 
number were not recognised in Power Pivot.  Adding these functions into 
the Excel realm brings Power Pivot closer to parity with its counterpart 
features in Power BI.

New DAX Functions in Excel Data Models and Power Pivot (Insiders Beta)
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The new functions are as follows:

1.	 ACCRINT

2.	 ACCRINTM

3.	 ALLCROSSFILTERED

4.	 AMORDEGRC

5.	 AMORLINC

6.	 BITAND

7.	 BITLSHIFT

8.	 BITOR

9.	 BITRSHIFT

10.	 BITXOR

11.	 COALESCE

12.	 COLUMNSTATISTICS

13.	 COMBINEVALUES

14.	 CONTAINSSTRING

15.	 CONTAINSSTRINGEXACT

16.	 CONVERT

17.	 COUPDAYBS

18.	 COUPDAYS

19.	 COUPDAYSNC

20.	 COUPNCD

21.	 COUPNUM

22.	 COUPPCD

23.	 CUMIPMT

24.	 CUMPRINC

25.	 DB

26.	 DDB

27.	 DISC

28.	 DISTINCTCOUNTNOBLANK

29.	 DOLLARDE

30.	 DOLLARFR

31.	 DURATION

32.	 EFFECT

33.	 ERROR

34.	 FIRSTNONBLANKVALUE

35.	 FV

36.	 GENERATESERIES

37.	 IF.EAGER

38.	 INTRATE

39.	 IPMT

40.	 ISAFTER

41.	 ISINSCOPE

42.	 ISPMT

43.	 ISSELECTEDMEASURE

44.	 LASTNONBLANKVALUE

45.	 MDURATION

46.	 NAMEOF

47.	 NOMINAL

48.	 NONVISUAL

49.	 NORM.DIST

50.	 NORM.INV

51.	 NORM.S.DIST

52.	 NORM.S.INV

53.	 NPER

54.	 ODDFPRICE

55.	 ODDFYIELD

56.	 ODDLPRICE

57.	 ODDLYIELD

58.	 PDURATION

59.	 PMT

60.	 PPMT

61.	 PRICE

62.	 PRICEDISC

63.	 PRICEMAT

64.	 PV

65.	 QUARTER

66.	 RATE

67.	 RECEIVED

68.	 REMOVEFILTERS

69.	 RRI

70.	 SELECTEDMEASURE

71.	 SELECTEDMEASUREFORMATSTRING

72.	 SELECTEDMEASURENAME

73.	 SELECTEDVALUE

74.	 SLN

75.	 SYD

76.	 T.DIST

77.	 T.DIST.2T

78.	 T.DIST.RT

79.	 T.INV

80.	 T.INV.2T

81.	 TBILLEQ

82.	 TBILLPRICE

83.	 TBILLYIELD

84.	 TREATAS

85.	 UNICHAR

86.	 USEROBJECTID

87.	 UTCNOW

88.	 UTCTODAY

89.	 VDB

90.	 YIELD

91.	 YIELDDISC

92.	 YIELDMAT.
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It is recognised elsewhere in this newsletter SELECTEDVALUE is 
mentioned (see Power Pivot Principles for more details) – good to see 
our advice will be out of date very soon!!

Presently, this feature is available to Beta Channel users running Version 

2208 (Build 15504.10000 ) or later.  It should be noted that Data Models 
may only be created in Excel for Windows and Power Pivot is a COM add-
in and therefore must be installed.

It’s common to copy text from a web page, an email or another document 
and then paste it into Excel.  Often, your goal is to match the format 
that’s already in place in the cell or range where you’re pasting.  Now 
you can simply copy the content that you want to paste into an existing 
worksheet and press CTRL + SHIFT + V.

A lot of the keyboard shortcut fraternity have become very excited by 
this one (I must confess this has passed me by a little).  It’s not to say you 
couldn’t do this previously, it’s just it took more steps, e.g.

	 •	 Paste the copied content by pressing CTRL + V, and then select  
		  ‘Paste Values’ or ‘Match Destination Formatting’ in the ‘Paste  
		  Options’ dialog box

	 •	 Select ‘Paste Values’ or ‘Match Destination Formatting’ in the  
		  Paste drop-down menu in the Ribbon (press ALT + H + V to open  
		  the menu with the keyboard)

	 •	 Press CTRL + ALT + V to open the Paste Special dialog, choose  
		  ‘Values’ or ‘Text’, and then press ENTER.

Goodness me, those long winter nights will just fly by now.

The updated version of the grid with all the new features is fast becoming 
too complicated to show here.  Nonetheless, you can find the interactive 
links at aka.ms/ExcelFeaturesFlyer. 

New Paste Options when using keyboard shortcuts (Insiders Beta)
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Imagine I were to borrow $300,000 over 25 years at an interest rate of 6% p.a.  Assuming no 
final amount to pay (i.e. no bullet repayment) and payments were made monthly at the end of 
each month (“in arrears”), interest would accrue over the month at 6%/12 = 0.50% per month  
(since there would be no compounding of interest monthly as it would be paid each 
month and I will simplify that all months are of equal length).

Using Goal Seek, the PMT function or algebraic methods, I could soon determine the monthly payment would be $1,932.90:

The A to Z of Excel Functions: IPMT

More next month, we’re sure.

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

You can see that over the 300 months the outstanding balance reduces 
to zero from an initial loan of $300,000.  The monthly payments (column 
H) remain constant, but the interest reduces as it calculates the opening 
balance (for payments in arrears, i.e. the repayment is not included) 
multiplied by the monthly interest rate, e.g. for cell I29, interest is 
calculated as

=G29*$I$13

As long as you calculate this table, the formulae are simple.  But what if 
you don’t want to have to generate this time every time you wanted to 
know the interest element of the monthly payment for a given month?  
You may use the IPMT function, which will give the same solution, but be 
negative instead.  This is because Excel’s financial functions distinguish 
between cash inflows (positive) and outflows (negative).  

It employs the following syntax to operate:

IPMT(rate, per, nper, pv, [fv], [type])

 The IPMT function has the following arguments:

	 •	 rate: this is required and represents the constant interest rate for the loan
	 •	 per: this is required, and specified the period to be considered, between periods 1 and nper
	 •	 nper: this is also required and denotes the total number of payments for the loan

	 •	 pv: also necessary, this is the present value, or the total amount that a series of future payments is worth now, also known as the principal  
		  (i.e. what you are borrowing)
	 •	 fv: this is the first of two optional arguments.  This is the future value, or a cash balance you want to attain, after the last payment is made.  	
	 •	 If fv is omitted, it is assumed to be zero (0), i.e. the future value of a loan is nil
	 •	 type: this final argument is also optional.  This the number zero (0) or one (1) and indicates when payments are due: 

It should be further noted that: 

	 •	 the interest payment returned by IPMT relates to interest but considers no effect from taxes, reserve payments or other fees sometimes 	
		  associated with loans

	 •	 make sure that you are consistent about the units you use for specifying rate and nper.  If you make monthly payments on a four-year loan  
		  at an annual interest rate of 12%, use 12%/12 for rate and 4*12 for nper.  If you make annual payments on the same loan, use 12% for the  
		  rate and 4 for nper. 

type Payments due

0 or omitted At the end of the period

1 At the beginning of the period

There are many techniques employed to value an asset, a project, a business, a shareholding, and so on.  However, one is arguably more common 
than the rest these days – Net Present Value (NPV) using discounted cash flows.

A discounted cash flow (DCF) is a straightforward computation:

	 •	 Let’s assume inflation is running at 10% (and we will assume this is after tax as we all earn our wages after tax and increases in spending  
		  affect this after-tax wage)

	 •	 Something that costs $100 this year will cost 10% more next year, i.e. $110
	 •	 Something that costs $110 next year will cost 10% more the year after, i.e. $121
	 •	 Something that costs $121 in that year will cost 10% more the following year, i.e. $133.10
	 •	 However, they are all worth the equivalent of $100 now (as we “discount” these future values back to their present values).

The A to Z of Excel Functions: IRR
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Note that all of these valuations are for a point of time not a period.  This 
is a common mistake in modelling.  We have to understand when we 
assume the cash flows will occur.  The three most common assumptions 
are at the start, the middle or the end of the period in question.  This 
assumption will obviously vary the overall valuation as a consequence.

Valuations include both cash inflows and cash outflows.  Adding up all 
these positive and negative present values, provides a netted off total: 
the Net Present Value (NPV).  The aim is to generate a positive return (a 
positive NPV) for a given rate of discounting, known as the discount rate.

The Internal Rate of Return (IRR) is the name given to the discount rate that makes the Net Present Value (NPV) of a range of cashflows zero.  For 
example, if I invest $100 now and receive $121 back in two years’ time this would give me an annual IRR of 10% since:

	           ($100) + PV($121) = ($100) + $121 / (1 + 10%)2 

				    = ($100) + $100

			        NPV	 = 0

It is often used to calculate cost of capital hurdle rates, bond rates, discount rates implicit in leases and Compound Annual Growth Rates, amongst 
other tasks.  

For cashflows with equal periodicity, Excel has a function that will estimate the IRR:

	 •	 IRR(values, [guess]) returns the periodic IRR for a set of sequential cashflows occurring on a regular periodic basis.  There must be at least  
		  one positive and one negative value in the range.  IRR will then cycle through an iterative technique (up to 20 times) to try and find an answer  
		  which is accurate to within 0.00001%

	 •	 If the guess is not specified, Excel will assume that it is 10% (0.1).

Both are fraught with problems in practice and the associated Excel file provides several documented examples.  However, before we discuss some 
of the problems with the functions, let me compare and contrast with a simple example:

In the illustration above, we consider three slightly different cashflows.  
The first one has the old faithful “hockey stick” projections of an outflow 
followed by five successive cash inflows.  In our example, this would give 
us a periodic IRR of 1.64%.  If the periods were months and we wished 
to convert this to annual rate then, using the compounding formula, this 
would be:

(1 + 1.64%)12 -1 = 21.54%.

The second example for IRR gives the same rate – which is correct.  Start 

dates for IRR are irrelevant: the only thing that matters is how long after 
the initial cashflow subsequent flows occur.

Unfortunately, the third scenario is not right and demonstrates a 
weakness in the IRR function.  Here, the outflow still occurs in the first 
period, but then there is a two-month delay before the inflows are 
received.  Clearly, this will impact both the NPV and the IRR.  The IRR is 
unaffected however – because blanks are ignored by the IRR function.  
To get Excel to calculate the IRR correctly here, zeroes should be entered 
into the two blank cells.

There can be more than one IRR.  Every time a cashflow series changes sign (i.e. goes from positive to negative or vice versa) there is potentially 
another solution.  Consider the following:

More than One Solution
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Here, prompted by a guess in the sister XIRR function (albeit of the other solution 21.43%), XIRR and IRR return two different IRRs associated with 
this cashflow scenario.

It is important to not only check that an IRR gives an NPV of zero [0] but that it is also the correct one in the circumstances.

There are times when accuracy is paramount, e.g. bond issues involving 
large sums of money.  Excel will only calculate IRR on a maximum cycle 
of 20 times.  Goal Seek, on the other hand, can calculate on a cycle of up 
to 32,767 iterations (this may be changed in Excel Options, ALT + T + O) 
with greater accuracy.

Therefore, when it is business critical, I always use Goal Seek to calculate 
IRRs.  It is a very simple approach and uses the longhand checking 
approach described above.  For example:

Here, an NPV calculation is constructed long hand with the discount rate an input in cell E46 (this is similar to an example in the attached Excel file).

Next, call up Goal Seek (ALT + T + G):

The NPV (cell F57 here) can be set to zero by Goal Seek, by changing the rate in cell E46.  Once you have clicked ‘OK’ in the dialog box, the algorithm 
will cycle through to a solution where possible with the NPV displayed at the same time to confirm that the value obtained is indeed the IRR.

It may be a cumbersome method, but give me reliability over elegance any day.

More Excel Functions next month.

So What Would You Use Instead?

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

The challenge this month was to spill a range of cells that unpivot some 
last columns of an array.  Easy, yes?

When you work with pivoted data that has a structure similar to a 
PivotTable, it is sometimes difficult to look up a value based on multiple 
column and row criteria.  To make it simpler, you might unpivot the data.  
Most of the time, you may choose to use the useful ‘Unpivot Columns’ 
feature in Power Query, but this will require refreshing when the data 
is modified.

This challenge was designed to make you think outside the box to 
find another way using only Excel formulae, so that the results refresh 
automatically.  

This month’s challenge was to write a formula in one cell using dynamic 
arrays (see, we’re nice – we gave you a hint!) that would spill a range of 
cells to unpivot only the last three [3] columns (i.e. x, y and z) of an array.  
The result should look like the array generated on the right based on the 
inputs adjacent and to the left (below):

As always, there were some requirements:

	 •	 the formula needed to be in just one cell (no “helper” cells)

	 •	 this was a formula challenge; no Power Query / Get & Transform or VBA!

	 •	 the formula needed to be flexible, so that if we adjusted the number of rows and / or columns of the input table, the formula should still work

	 •	 obviously, the numbers of rows / columns of the output table could not exceed the row / column limitations of Excel.

Beat the Boredom Suggested Solution

Before explaining our solution, we will clarify how we came up with it first.  Firstly, inputs of the formula need to include:

	 •	 the Data table in the question
	 •	 the number of columns that will not be unpivoted, which is two [2] (i.e. Col 1 and Col 2).  We name it as ColstoKeep.

Therefore, the number of columns to unpivot is three [3], which is calculated as below.  We name this number as UCols.

=COLUMNS(Data[#All]) – ColstoKeep

Secondly, we need to consider some features (e.g. numbers of rows and columns) of the output array.  After we unpivot the table, they should be 
calculated as below:

	 •	 number of rows: nine [9]

=(ROWS(Data[#All]) - 1) * UCols

	 •	 number of columns: four [4].  The output table will include the first two [2] columns of initial table and two [2] additional columns for the 	
		  old row headers (i.e. x, y and z) and values (i.e. numbers in Data table in this case).

=ColstoKeep + 2

Thirdly, to create a Dynamic Range for the output, we need the help of the INDEX (please refer to https://www.sumproduct.com/blog/article/a-
to-z-of-excel-functions/the-index-function) and SEQUENCE (please refer to https://www.sumproduct.com/thought/creating-a-calendar-with-
dynamic-arrays) functions.

The row and column index numbers of output need to be created by SEQUENCE as follows.  We will call them RowID and ColID.

	 •	 RowID:

=SEQUENCE((ROWS(Data[#All]) - 1) * UCols)

	 •	 ColID:

=SEQUENCE(1, ColstoKeep + 2)

Suggested Solution
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Finally, the trick of this challenge is to use ColID with an IF statement (see https://www.sumproduct.com/blog/article/a-to-z-of-excel-functions/the-
if-function for further details) (below) as a connector for three different INDEX functions, i.e.

“If ColID is less than or equal to ColstoKeep, then get the first two [2] columns of Data,
 else if ColID is equal to ColstoKeep + 1, then get the Row Header of unpivoted columns of Data,
else get the Values of Data.”

The result is as follows:

You may wonder why the challenge only allows a formula cell when there are several working steps above.  Our solution is a combination of all 
described steps above within a LET formula (see https://www.sumproduct.com/blog/article/a-to-z-of-excel-functions/the-let-function) as follows:

=LET(Tbl, Data[#All], 
ColstoKeep, 2, 

UCols, COLUMNS(Tbl)-ColstoKeep, 
RowID, SEQUENCE((ROWS(Tbl)-1)*UCols), 

ColID, SEQUENCE(1,ColstoKeep+2), 
Ro, ROUNDUP(RowID/UCols,0)+1, 

Col, MOD(RowID-1,UCols)+1+ColstoKeep, 
IF(ColID<=ColstoKeep,INDEX(Tbl,Ro,ColID), IF(ColID=ColstoKeep+1,INDEX(Tbl,1,Col), INDEX(Tbl,Ro,Col))))

There are seven [7] variables:

	 •	 Tbl is an input table to unpivot
	 •	 ColstoKeep is the number of first columns you do not want to unpivot

	 •	 UCols is the number of unpivoted columns

	 •	 RowID and ColID are row and column indices of the output table

	 •	 Ro and Col are initial row and column positions of Values in the input table.

Then, the final part of the formula is the calculation to unpivot the last three [3] columns, viz.

Although it is a long and complex formula, you can apply it to your input table by only replacing the values for Tbl and ColstoKeep.

Until next time.
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 	 	
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from 
www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This month, we look again at the CTRL 
and SHIFT keys, but this time combined with various special characters that Excel uses:
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Melbourne Address:	SumProduct Pty Ltd, Ground Floor, 470 St Kilda Road, Melbourne, VIC 3004
Registered Address:	SumProduct Pty Ltd, Level 14, 440 Collins Street, Melbourne, VIC 3000

Keystroke What it does
CTRL + SHIFT + Down Arrow Extend selection down to last cell in area down
CTRL + SHIFT + END Extend selection to the last cell in the sheet
CTRL + SHIFT + ENTER Fill value in edited cell into all cells and do not move
CTRL + SHIFT + ESC Task Manager (Windows – overriding an Excel command)
CTRL + SHIFT + EXECUTE Fill value in edited cell into all cells and do not move
CTRL + SHIFT + HOME Extend selection to the cell that resets the window or the pane
CTRL + SHIFT + Left Arrow Extend selection down to last cell in area left
CTRL + SHIFT + Page Down Extend selection one sheet down (sheet tab to the right)
CTRL + SHIFT + Page Up Extend selection one sheet up (sheet tab to the left)
CTRL + SHIFT + RETURN Fill value in edited cell into all cells and do not move
CTRL + SHIFT + Right Arrow Extend selection down to last cell in area right
CTRL + SHIFT + SPACE Select contiguous area
CTRL + SHIFT + TAB Previous Window
CTRL + SHIFT + Up Arrow Extend selection up to end of region

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Location Course Date Date Duration Duration

Online (Australia) Power Pivot, Power Query and Power BI 7 - 9 Dec 2022 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 14 Dec 2022 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 1 Day

Online (Australia) Financial Modelling 15 - 16 Dec 2022 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 2 Days

Upcoming SumProduct Training Courses - COVID-19 update
Due to the COVID-19 pandemic that is currently spreading around 
the globe, we are suspending our in-person courses until further 
notice.  However, to accommodate the new working-from-home 
dynamic, we are switching our public and in-house courses to 
an online delivery stream, presented via Microsoft Teams, with 
a live presenter running through the same course material, 
downloadable workbooks to complete the hands-on exercises 
during the training session, and a recording of the sessions for 

your use within 1 month for you to refer back to in the event 
of technical difficulties.  To assist with the pacing and flow of 
the course, we will also have a moderator who will help answer 
questions during the course.

If you're still not sure how this will work, please contact us at 
training@sumproduct.com and we'll be happy to walk you 
through the process.
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